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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part 
of Avid Technology, Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of 
that license by visiting Avid's Web site at www.avid.com. The terms of that license are also available in the 
product in the same directory as the software. The software may not be reverse assembled and may be 
used or copied only in accordance with the terms of the license agreement. It is against the law to copy the 
software on any medium except as specifically allowed in the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 
4,746,994; 4,970,663; 5,045,940; 5,077,604; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 
5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,583,496; 5,584,006; 
5,627,765; 5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 
5,752,029; 5,754,180; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 6,061,758; 
6,532,043; 6,546,190; 6,636,869; 6,747,705. Other patents are pending.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording, for any purpose without the express written permission 
of Avid Technology, Inc.

Copyright © 2004 Avid Technology, Inc. and its licensors. All rights reserved. 

The following disclaimer is required by Apple Computer, Inc.
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, 
REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS 
MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF 
IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT 
APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE 
OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of 
their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its 
documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices 
and this permission notice appear in all copies of the software and related documentation, and (ii) the 
names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the 
software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, 
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED 
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
Portions of this software are based on work of the Independent JPEG Group.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to 
derive a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray 
Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to 
perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
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consequential Damages including lost profits, or damages resulting from loss of use or inability to use 
reseller’s products or the software for any reason including copyright or patent infringement, or lost data, 
even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, 
including warranties with respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 
products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties 
under license from Videomedia, Inc. Use of this software will allow “frame accurate” editing control of 
applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win 
software and Sample Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial 
computer software” or “commercial computer software documentation.” In the event that such Software or 
documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with 
respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to 
FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid DNA, AVIDdrive, AVIDdrive Towers, Avid Mojo, AvidNet, AvidNetwork, AVIDstripe, Avid Unity, 
Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, D-Fi, D-fx, Digidesign, 
Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, Digital Nonlinear Accelerator, 
DigiTranslator, DINR, D-Verb, Equinox, ExpertRender, FieldPak, Film Composer, FilmScribe, FluidMotion, 
HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, Intraframe, iS9, iS18, iS23, 
iS36, Lo-Fi, Magic Mask, make manage move | media, Marquee, Matador, Maxim, MCXpress, 
Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, 
Media Reader, Media Recorder, MEDIArray, MediaShare, Meridien, MetaSync, NaturalMatch, Nearchive, 
NetReview, NewsCutter, Nitris, OMF, OMF Interchange, OMM, Open Media Framework, 
Open Media Management, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, 
Softimage, Sound Designer II, SPACE, SPACEShift, Symphony, the Avid|DS logo, Trilligent, UnityRAID, 
Vari-Fi, Video Slave Driver, VideoSPACE, and Xdeck are either registered trademarks or trademarks of 
Avid Technology, Inc. in the United States and/or other countries.

iNEWS, iNEWS ControlAir, and Media Browse are trademarks of iNews, LLC.

All other trademarks contained herein are the property of their respective owners.

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
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WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — 
Broadcasters — Content creators of every genre — Just finished an incredible project and want to 
share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid FilmScribe User’s Guide • Part 0130-06784-01 • December 2004
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Using This Guide

Avid® FilmScribe™ is an application that allows you to create, modify, and 
manage cut lists and change lists. FilmScribe lists can be used to prepare 
various postproduction elements of a film project, including work prints and 
final cuts. The FilmScribe application opens bins created on Avid editing 
systems and generates lists from sequences in those bins that contain the 
appropriate film information. FilmScribe is a standalone application: it can 
open bins and generate lists without an Avid editing system being open or 
even present on your computer.

This manual is intended for FilmScribe users from beginning to advanced 
levels. Typically, these users are editors or assistants who are using an Avid 
editing system to edit a film project and who need to create precise lists to 
guide the preparation of film prints and cuts.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware that 
are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, 
reminders, recommendations, and strong suggestions.

c A caution means that a specific action you take could 
cause harm to your computer or cause you to lose data.
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w A warning describes an action that could cause you 
physical harm. Follow the guidelines in this document 
or on the unit itself when handling electrical 
equipment.

> This symbol indicates menu commands (and 
subcommands) in the order you select them. For 
example, File > Import means to open the File menu 
and then select the Import command.

t This symbol indicates a single-step procedure. 
Multiple arrows in a list indicate that you perform one 
of the actions listed.

k This symbol represents the Apple or Command key. 
Press and hold the Command key and another key to 
perform a keyboard shortcut.

Margin tips In the margin, you will find tips that help you perform 
tasks more easily and efficiently.

(Windows), (Windows only), 
(Macintosh), or (Macintosh 
only)

This text indicates that the information applies only to 
the specified operating system, either Windows XP or 
Macintosh OS X.

Italic font Italic font is used to emphasize certain words and to 
indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action
k+key or mouse action

Press and hold the first key while you press the last 
key or perform the mouse action. For example, 
k+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action
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If You Need Help

If you are having trouble using this Avid application:

1. Retry the action, carefully following the instructions given for that task in 
this guide. It is especially important to check each step of your workflow.

2. Check the ReadMe for the latest information that might have become 
available after the documentation was published. The ReadMe is supplied 
in your Avid application folder. The ReadMe file is also available in the 
Help.

n The ReadMe file is also available on the Avid Knowledge Base.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online 
services are available 24 hours per day, 7 days per week. Search this 
online Knowledge Base to find answers, to view error messages, to access 
troubleshooting tips, to download updates, and to read/join online 
message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local 
Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call Avid Sales 
at 800-949-AVID (800-949-2843).

http://www.avid.com/onlinesupport
http://www.avid.com/training


 Using This Guide

12



Chapter 1
Understanding Film Lists

At various stages of postproduction, you need to generate lists that can be used 
to prepare conformed cut previews, optical effects, audio tracks, and 
eventually the final cut. FilmScribe provides tools for creating frame-accurate 
lists that can be used to conform a work print, a film negative, audio tracks, or 
videotape transfers. 

This chapter provides an overview of the situations in which you can use cut 
lists and change lists. It also describes specific types of optional lists you can 
generate.

This chapter includes the following major sections:

• Film List Concepts

• Cut Lists Versus Change Lists

• Frame Reference Numbers

• Understanding Optional Lists

• Using Icons in Lists to Represent Edits

Film List Concepts

The Cut List and Change List tools allow you to generate detailed information 
for conforming the work print, the negative, Visual Effects (VFX) information, 
or Digital Picture Exchange (DPX) file-based workflows of a film project in 
various contexts:

• For screening of dailies or selects, you can generate scene and pull lists 
that the lab or an assistant editor can use to prepare a work print.
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• For screenings of a current cut, you can generate ink number lists that the 
assistant editor can use for conforming a work print and magnetic track.

• For developing the final sound tracks, you can generate audio change lists 
that the sound department can use for editing and mixing the original 
audio source reels.

• For preparing optical effects, you can generate lists that the optical house 
can use for comparing versions and generating optical effects.

• To compare different versions of a sequence or to determine a project’s 
reels, you can generate lists containing information about multiple 
sequences that the assistant editor can use to combine reels or bring 
conformed work prints up-to-date.

• For the final cut, you can generate key number lists that the negative cutter 
can use for conforming the negative.

• At all stages, you can also use your Avid editing system to record a digital 
cut of the sequence or a digital cut of the audio tracks for use in screening 
or as an aid in conforming the cuts.

The following section describes the two main types of lists you can generate in 
FilmScribe.

Cut Lists Versus Change Lists

Film cut lists and change lists provide breakdowns of exactly which frames 
should be cut from the work print or original negative. Unlike video edit 
decision lists (EDLs), which must conform to the specifications and 
limitations of various edit controllers, film lists are read by assistant editors or 
negative cutters. Avid’s cut lists also include industry-standard optical list 
information.

Cut lists and change lists serve two basic purposes:

• A cut list can be generated the first time to conform a work print, negative, 
sound track, or optical effect to match the sequence.

• A change list is generated to simplify the process of updating conformed 
cuts to match and compare changes in versions of the sequence or 
sequences.
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In FilmScribe, each cut list uses the existing frame reference numbers 
contained in the bins to represent edit details in a sequence. Change lists use 
the same reference numbers to compare two or more versions of a sequence or 
a set of sequences to show only the changes necessary to bring previously 
conformed cuts up to date, which is useful for comparing versions of edited 
sequences.

When you are comparing a new sequence with a previous version of the same 
sequence, the change list indicates the following categories of sequence 
changes:

• Insertions for new material to be added

• Deletions of old material no longer needed

• Trims to be made to the heads, tails, or middles of the edits

• Moves that consist of a matched pair of deletions and insertions of an 
entire shot or shots

• Optional information that details which portions of the sequence should 
not be altered

The following illustration compares cut lists and change lists.

Frame Reference Numbers

You can generate all the standard frame-reference information required for an 
assistant editor or negative cutter to conform a cut, provided that information 
has been entered in the bin.

.................................................................
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................
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Conformed Cut 1A
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Clip Z

Clip ZClip YClip X

New Clip
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Change
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n If you did not log a category of data during logging and capturing, you can 
add optional information to the bin in your Avid editing system at any time 
before working with the list in FilmScribe. You can also add information using 
Avid MediaLog™. For example, if you add ink numbers in the Ink Number 
column after editing, the system includes these in the lists.

In addition, FilmScribe can display unique information not normally included 
in a conventional cut list. For example, you can include the following 
information in a list:

• Frame images. These are the thumbnail images of the initial frames of 
the clips in your sequence. They appear in the list only if you have:

- The Frame Images option selected in the Cut List Tool window

- QuickTime® software installed

- QuickTime files of your sequences

You can double-click the thumbnail image to open and play it in 
QuickTime.

For information about Cut List options, see “Understanding the Cut List 
Tool” on page 37. For information about QuickTime movies, see 
“Viewing Sequences as QuickTime Movies” on page 53 and “Preparing 
QuickTime Movies” on page 88.

• Comments. These are any added comments you associated with a clip in 
the sequence during editing. They appear in the assemble and optical lists 
only.

• Locator comments. These are any comments you associated with a 
particular clip using locators. They appear in the assemble and optical lists 
only.

Comments and locators can be very useful. For example, you can use locators 
to mark where music begins, or you can provide specific color-correction 
instructions for a frame or clip and print these notes as part of your list. 
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Understanding Optional Lists

Both cut lists and change lists include the use of optional lists that 
communicate specific tasks to the assistant editor, the negative cutter, the 
sound department, or the optical house. For example, these lists can instruct 
the facility to:

• Pull or assemble cuts, scenes, or takes in a particular order

• Remove takes that are no longer needed

• Layer and composite optical effects

• Check for duplicate frames and jump cuts

• Print or flag the required duplicate negative

The heart of a cut list or change list is the assemble list, which provides a 
breakdown of the sequence into all its required parts. These might include 
scenes and takes, optical effects, and duplicate frames, all of which you can 
compile in additional, supporting sublists. You can also generate pull lists, 
which literally display material to be pulled by the assistant editor. The 
following illustration shows an assemble list.

The following sections describe each type of optional list.
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Assemble Lists

The assemble list shows the order in which a sequence’s clips, optical effects, 
or standard dissolves and fades are assembled from start to finish in the edited 
sequence. The assemble list also flags duplicate frames. In addition, you can 
choose to display optional settings and information categories such as camera 
rolls, sound rolls, lab rolls, comments, or locators. The types of numbers used 
for tracking can be key numbers and ink numbers. These numbers are 
displayed as a user-selected footage or frame count.

A-Roll Versus A/B-Roll Conforming

FilmScribe assemble lists can represent either of the two conforming methods: 
A-roll or A/B-roll. Before generating a cut list or change list containing an 
assemble list, you select one of these methods based on the following criteria:

• A-roll or single-strand. Used primarily for 35mm film editing, this 
method requires the compositing of all multilayer effects into a single 
layer (including laboratory-standard dissolves and fades) before assembly. 
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A-roll assemble lists contain information about all single-layer, 
straight-cut events. All other information about the sequence is described 
in the optical list.

• A/B-roll or double-strand. Used primarily for 16mm film editing, this 
method limits the amount of optical work by managing most standard 
dissolves and fades using two strands of film. A/B-roll assemble lists 
contain information about single-layer, straight-cut events as well as 
laboratory-standard dissolves and fades. All other information about the 
sequence is described in the optical list.

The following illustration shows the two types of conforming methods.

A laboratory-standard dissolve or fade is a multiple of 12 or 16 frames and is 
between 12 and 96 frames long. All other transition effects, titles, graphics, 
dissolves, and fades of nonstandard length appear in the optical list.

n Sound lists are always displayed as A/B-roll and describe dissolves of any 
length.

Optical Lists

Optical lists specify the source material required to create special effects and 
any edit event other than a straight cut, such as a dissolve or fade that must be 
sent to an optical house for creation. The optical list presents each optical 
event in the order in which it appears in the sequence and includes 
specifications based on either ink numbers, Aux ink numbers, or key numbers.
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Types of Effects Supported by Optical Lists

FilmScribe optical lists support the following effects and combinations of 
effects:

• All standard- and nonstandard-length transition effects, such as dissolves 
and fades

• Standard blend effects, such as superimpositions, title effects, matte key 
effects, luma keys, and chroma keys

• Single-layer segment effect blowups, including moving blowups and 
resize flips and flops

• Other standard film effects such as flips, flops, flip-flops, and motion 
effects

• Combinations of single-layer effects, such as a flipped motion effect

• Tracking of keyframed previsualization markers 

• Clone and other paint effects

Part of a sample optical list
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• Combinations of single-layer effects with blend effects, such as a key 
effect applied to a motion effect

• Transition and blend effects that appear on two separate picture tracks

• Overlapping transition effects on two separate picture tracks

n FilmScribe cut lists do not describe standard film masks that you apply to a 
clip or sequence to view a different aspect ratio. Standard masks are usually 
applied only after the conforming of a work print or negative. These masks are 
not effects and are used only to represent the cutoff of projected print in the 
theatre. Custom masks, which are effects, are described in the optical list.

Dupe Lists

Dupe lists refer to all the source material that the lab must duplicate before 
conforming the film negative. Additionally, dupe lists display unintended 
duplicate frames you might have edited into the sequence.

n To avoid including unnecessary dupes in your lists, use the Dupe Detection 
function during editing. Dupe handle lengths are set in the Timeline Settings 
dialog box in Avid editing systems. For more information, see the Help for 
your Avid editing system. 

The listed duplicate frames are organized within sets of dupe groups. Each 
dupe group set provides the IN and OUT points of two or more entries that are 
duplicates of each other in related sections of the sequence.
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Dupes are also indicated in the assemble and pull lists by default, regardless of 
whether or not you choose to generate a separate dupe list.

A sample dupe list
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Pull Lists

Pull lists display selected elements of the sequence in various sort orders. The 
pull lists show dupes but not comments or locators.

Change Pull Lists and Change Discard Lists

When you are generating a change list, the Change List tool provides two 
additional options: the change pull list and the change discard list.

• The change pull list is similar to the pull list, except that it lists only new 
clips or effects that you need to insert into the updated cut.

• The change discard list displays each clip that has been removed from the 
updated sequence.

A sample pull list
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Scene Pull Lists

Scene pull lists show the cuts arranged in the following sort order:

• Scene and take

• Reel numbers

You can customize the sort order in the Options pane. For more information, 
see “Pull Lists” on page 80.

The scene pull list contains one entry for each scene and take that was 
referenced in the assemble list, as entered in the Sc/Tk column of the bins. 
Each entry displays the entire length of the take as defined by the clip from 
which it came. The Sc/Tk column must be filled in within the bin to generate a 
scene pull list.

Optical Scene Pull Lists

Optical scene pull lists show all the source material required to re-create the 
optical effects in the sequence. The optical scene pull list contains the same 
information as a scene pull list except that:

• Each optical is listed per scene.

• Takes required to re-create the optical are listed by scene number.

A sample scene pull list
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Using Icons in Lists to Represent Edits

Icons that graphically represent edit events can appear in your lists.

n These icons do not appear in WebLists or TabbedLists.

To display the icons:

t Select the Icons option in the Cut List or Change List tool. 

A sample optical scene pull list
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Cut List

Change List

Cut List icon

Change List icon
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The following tables list the icons available. 

Cut List and Change List Available Icons  

Cut List and Change List

Fade Out 

Fade In 

 
Dupe

 
Dissolve 

 
Optical

 
Optical Media

Media Offline

Change List-Only Available Icons  

Change List Only

 
Delete

 
Insert

 
Insert Head
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The Bad Clip icon indicates clips that have discontinuity of edgecode. 
Discontinuities occur normally between scenes or takes in each KEM roll. 
When you create scene or take subclips from a captured KEM roll master clip, 
however, each subclip normally includes its own continuous edge code. If a 
subclip or edited portion of a KEM roll master clip accidentally includes a 
break in edge code between takes, then the Bad Clip icon appears in the lists.

c All list information following the Bad Clip icon is unreliable. If the Bad 
Clip icon appears in the lists, check all clips for the edge code information, 
adjust the errors, and generate new lists.

 
Insert Tail

 
Delete Tail

 
Delete Head

Change List-Only Available Icons (Continued)  

Change List Only

Bad Clip icon



Chapter 2
Working with FilmScribe

This chapter explains the main elements of FilmScribe and procedures for 
working with the application.

• FilmScribe Workflow

• Starting and Quitting FilmScribe

• Understanding the FilmScribe Interface

• Working with Bins

• Working with the Cut List Tool and the Change List Tool

• Working in the List Window

• Viewing Sequences as QuickTime Movies

• Saving, Opening, and Printing Lists

• Using the WebLists Template

• Using the TabbedLists Template

• Working with Multiple Cuts and Reels

• Using the Matchback Option

FilmScribe Workflow

When you use FilmScribe to prepare a list, your work generally involves the 
same basic flow. The basic workflow contains the following steps: 

1. Open the bin that contains the sequence with which you want to work.

2. Open the Cut List tool or the Change List tool and bring the sequence into 
the tool from the bin.
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3. Select options in the tool window to customize the list, or apply an 
existing group of option settings.

4. Generate the list and view it in the List window or Web browser (for a 
WebLists template).

5. Save and print the list.

Under certain circumstances, you might also:

• Import the file into an application such as Microsoft Excel or FileMaker 
(for lists generated from the TabbedLists template).

• Reopen a saved list. 

• Work with more than one bin or sequence at the same time.

• View the sequence in the Movie window.

Starting and Quitting FilmScribe

You can start FilmScribe as a standalone application or, if you have a Media 
Composer Adrenaline system, you can start it from within your Avid 
application.

(Windows) To start FilmScribe:

t Click the Start button, and select Programs > Avid > Avid FilmScribe.

(Macintosh) To start FilmScribe:

t Double-click the FilmScribe icon on the desktop.

t Locate the FilmScribe application folder in the Applications folder, and 
then double-click the FilmScribe icon.

To start FilmScribe from within your Avid Media Composer Adrenaline 
application:

t Select Output > FilmScribe.

FilmScribe opens as the active window.

(Windows) To quit FilmScribe, do one of the following:

t Select File > Quit.

t Click the Close button in the upper right corner of the main application 
window.
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(Macintosh) To quit FilmScribe:

t Select File > Quit.

Understanding the FilmScribe Interface

The FilmScribe interface has the following main elements:

• Menu Bar

• Windows

• Help System

Menu Bar

The FilmScribe menu bar displays a series of menus that you can use to 
control the functions of the application.

FilmScribe has two groups of menus — those that always appear and those 
that appear only when a specific window type is active.

Menus That Always Appear

The following table lists the general menus that always appear on the menu 
bar and describes the commands in each menu.

General Menus  

Menu Description

File Provides commands for opening and closing bins and 
tools, saving and printing lists, and quitting the 
application.

Edit Provides commands for undoing and redoing the most 
recent user action and for basic editing functions.

Font, Style,
Size, Color

Provides commands for changing the appearance of the 
text in a cut list or a change list. You cannot change these 
parameters in Weblists or TabbedLists.

Windows Provides commands for positioning the status bar and for 
navigating the open windows.
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Menus That Appear for Specific Types of Windows

When you start FilmScribe, the menus listed in “General Menus” on page 31 
are the only menus that appear. However, once you open a window, a new 
menu appears to the left of the Windows menu. The menu that opens is 
specific to the type of window that is active. For more information on window 
types, see “Window Types” on page 33.

The following table lists the window-specific menus and describes the 
commands in each menu.

Help Provides commands for accessing the Help system.

General Menus (Continued)  

Menu Description

Window-Specific Menus  

Menu Description

Sequence Appears when a bin is the active window and provides 
commands for opening sequences in the Cut List tool or 
the Change List tool. You can also open the Sequence 
menu as a pop-up menu within a bin by right-clicking 
(Windows) or Ctrl+clicking (Macintosh) a sequence.

CutList Appears when the Cut List tool is the active window and 
provides commands for clearing sequences in the tool and 
for generating and previewing a list.

ChangeList Appears when the Change List tool is the active window 
and provides commands for clearing sequences in the tool 
and for generating and previewing a list.

List Appears when the List window is the active window and 
provides commands for expanding and collapsing the list 
view.

Movie Appears when the Movie window is the active window 
and provides commands that control the way the movie 
plays and the size of the window.
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Window Types

You work with sequences, list options, and lists in different windows within 
FilmScribe. The following table lists these window types and describes the 
tasks you can perform in each type.

Window Types  

Window Type Description

Bin Open any bin from an Avid editing system, sort the 
sequences in the bin, and select sequences to move into 
the Cut List tool and the Change List tool. For more 
information on bins, see “Working with Bins” on page 34.

Cut List Tool and 
Change List Tool

Prepare and generate cut lists in the Cut List Tool window 
and change lists in the Change List Tool window. Select 
which kinds of lists to generate, which sequences to 
generate from, and which tracks to include in your lists. 
Set options that define what kind of information goes into 
your lists. You can also work with option settings in the 
tool windows. For more information on the Cut List and 
Change List tools, see “Working with the Cut List Tool 
and the Change List Tool” on page 36. For more 
information on settings, see “Using Settings to Save, 
Recall, and Remove Options” on page 46.

List Preview the lists that you have generated or open 
previously saved lists. For more information on the List 
window, see “Working in the List Window” on page 49.

Movie View QuickTime movie versions of the sequences with 
which you work. This feature is available only when 
QuickTime is installed and you have created a QuickTime 
movie version of your sequence. For more information, 
see “Viewing Sequences as QuickTime Movies” on 
page 53.
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Using Help and Viewing the Readme File

The Help provides all the information contained in the Avid FilmScribe User’s 
Guide, and operates in a Web browser. To open the Help, select Help > Help 
or Help > Shortcuts in the Avid FilmScribe application. For information about 
using the Help, open the Using Help topic in the Help Contents.

The ReadMe file contains any important information that was discovered after 
the Help and manual were updated. To view the Readme file, Select Help > 
ReadMe.

Working with Bins

Bins are the specialized files used by Avid editing systems to organize clips 
and sequences. The first stage in generating lists with FilmScribe is to open 
one or more bins that contain the sequences with which you want to work.

FilmScribe can open bins that were created on Macintosh-based or 
Windows-based Avid editing systems. When you open a bin, FilmScribe 
displays all the sequences in that bin but does not display other kinds of files 
(such as clips and subclips) that might be in the bin.

Opening and Closing Bins

To open a bin:

1. Select File > Open.

A dialog box opens.

2. Navigate to the folder that contains the bin you want to open.

3. Click the bin you want.

4. Click Open.

The bin opens.

(Windows) To close a bin:

t Make the bin the active window, and then do one of the following:

- Select File > Close.

- Click the bin’s Close button
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(Macintosh) To close a bin: 

t Make the bin the active window, and then Select File > Close.

Understanding the Bin Window

A bin window has the following features:

• The status bar displays information about the project with which the bin is 
associated:

- The format of the project (for example, NTSC or PAL)

- The frames-per-second (fps) rate of the project (24, 25, or 30)

• The Refresh button reloads the most recently used bin, and allows you to 
keep the FilmScribe tool open while you make changes in your Avid 
editing application.

• The column heading buttons display the names of selected headings 
associated with that bin. For more information on bin headings, see the 
Help for your Avid editing system. 

• The Sort Direction button controls the order in which sequences in the bin 
are sorted.

• The Sequence display area shows a row of information for each sequence 
in the bin. Scroll vertically if you need to view all the sequences.

Sort direction buttonBin status bar

Sequence display area

Column heading buttonsRefresh button
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Sorting Items in Bins

You can sort the sequences in a bin by any of the column heading categories. 
For example, you might want to sort by reel number so that all the sequences 
from one reel are grouped together. FilmScribe sorts the sequences in 
alphabetical or numerical order, whichever is appropriate to the heading.

To sort items in a bin:

t Click the column heading button for the category by which you want to 
sort.

To switch between ascending (A to Z) and descending (Z to A) sort:

t Click the sort direction button, located at the far right of the column 
heading buttons.

The arrow on the button points up when ascending sort is selected and 
points down when descending sort is selected.

Working with the Cut List Tool and the 
Change List Tool

The Cut List tool and the Change List tool allow you to set options for the lists 
you want to generate.

Opening and Closing the Tools

To open the Cut List tool or the Change List tool, do one of the following:

t Select File > New Cut List.

t Select File > New Change List.

t Select a sequence in a bin, and then select the appropriate item from the 
Sequence menu. For more information, see “Using the Sequence Menu” 
on page 40.

To close the Cut List tool or the Change List tool, do one of the following:

t Click in the tool to make it active, and then select File > Close.

t Click the window’s Close button (Windows) or close box (Macintosh).
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Understanding the Cut List Tool

The Cut List tool has the following features:

• The Sequences pane displays currently loaded sequences.

• The Tracks pane allows you to select the tracks to be included in the list: 
video (picture) or audio tracks.

• The Lists pane allows you to select specific types of lists in addition to the 
main assemble list.

• The Title text box allows you to type a name for the list.

• The Settings pop-up menu allows you to save your current cut list settings 
and selections for future use.

Options paneSequences pane

Tracks 
pane and 
buttons

Title text 
box

Settings pop-up menu Preview button

Lists pane
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• The Preview button performs the following operations depending on the 
template you are using:

- For the TabbedLists template, FilmScribe prompts you for a folder 
name and stores the cut list or change list in the folder. You can open 
the file later in an application such as Microsoft Excel.

- For the WebLists template, FilmScribe stores all the related files in 
Avid Application/FilmScribeOutput/Title, and then opens the HTML 
file in your default Web browser.

- For all other templates, FilmScribe generates the list and opens the 
List window for previewing the list.

• The Options pane provides controls for customizing each of the lists you 
choose to generate.
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Understanding the Change List Tool

The Change List tool has many of the same features as the Cut List tool, with 
the following differences:

• The Change List tool has two sequences panes: one for the old versions of 
the sequences and one for the new versions.

• Because old and new sequences lists exist, the Change List tool has two 
Lists panes. The panes allow you to select assemble or dupe lists 
separately for each sequence to include in the comparison when 
generating the list.

New Lists pane

Old Lists paneOld Sequences pane

New Sequences pane

Change Lists pane
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• The Change Lists pane allows you to select the specific types of change 
lists you want to generate.

• The Change List tool has text entry boxes for Old Title and New Title.

Getting Sequences

This section describes how to get sequences into the Cut List tool and the 
Change List tool.

Dragging Sequences from Bins

To get a sequence by dragging:

t Drag the sequence you want from the bin to the Sequences pane in the 
Cut List tool, or to the Old Sequences or New Sequences pane in the 
Change List tool.

The name of the loaded sequence appears in the pane.

n If your sequences have unique Reel numbers, you can drag more than one 
sequence. To select more than one sequence, Shift+click each sequence you 
want, and then drag the sequences to the tool.

To add a sequence to a Sequences pane that already contains 
sequences:

t Press and hold the Alt key (Windows) or Option key (Macintosh) while 
you drag the additional sequence into the pane.

The name of the additional sequence is added to the pane.

c If you do not press and hold the Alt key (Windows) or Option key 
(Macintosh) while dragging additional sequences into a pane, FilmScribe 
replaces the contents of the pane with the new selection.

Using the Sequence Menu

When you use the Sequence menu commands to get sequences, you do not 
need to have the Cut List tool or the Change List tool open. FilmScribe opens 
the tool if it is not already open. 
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To get sequences using the Sequence menu:

1. Make the bin the active window.

2. Click the sequence you want.

3. Select the appropriate command from the Sequence menu:

- Open in CutList Sequences

- Open in ChangeList Old Sequences

- Open in ChangeList New Sequences

The Cut List tool or the Change List tool opens (if it is not already open), 
and the name of the sequence appears in the appropriate Sequences pane.

n You can also open the Sequence menu as a pop-up menu in a bin. To do this, 
click the sequence using the right mouse button (Windows) or Ctrl+click the 
sequence (Macintosh). 

To add a sequence to a list that already contains one or more sequences:

n Your sequences must have unique Reel numbers to load more than one in the 
Sequences panel.

1. Make the bin the active window.

2. Click the sequence you want.

3. Select the appropriate command from the Sequence menu:

- Append to CutList Sequences

- Append to ChangeList Old Sequences

- Append to ChangeList New Sequences

The Cut List tool or the Change List tool opens (if it is not already open), 
and the name of the additional sequence is added to the appropriate 
Sequences pane.

When you load the first sequence, FilmScribe determines whether the 
sequence was previously used to generate cut lists. If so, the settings that were 
last used are automatically displayed.
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Clearing Sequences

To clear sequences from the Sequences panes in the Cut List tool or the 
Change List tool:

1. Make sure that the tool from which you want to clear sequences is the 
active window.

2. Select Clear Sequences from the CutList menu or the ChangeList menu.

FilmScribe removes the names of sequences in the panes.

n Closing the Cut List tool or the Change List tool also clears sequences from 
the Sequences panes. (Most other settings are saved when you close the tool. 
For more information, see “Using Settings to Save, Recall, and Remove 
Options” on page 46.)

Selecting Tracks

The Tracks pane displays a button for each track that exists in the sequence. 
FilmScribe generates lists only for the tracks you select.

To select or deselect tracks, do one of the following:

t Click a track button to select or deselect it.

t Select one of the following:

- CutList > Select All Tracks

- CutList > Deselect All Tracks

- ChangeList > Select All Tracks

- ChangeList > Deselect All Tracks

n In the Change List tool, the buttons in the Tracks pane correspond to the 
sequence you loaded into the New Sequences pane, not that in the Old 
Sequences pane.

If the sequence is a 30-fps sequence (that is, a matchback project), audio 
tracks are not shown because matchback applies to picture-only sequences. 
Generate a separate edit decision list (EDL) for sound. For more information, 
see the documentation for your Avid editing system and for EDL Manager.
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n If you select the Separate List for Each Channel option from the Global 
Options panel, you can select any combination of picture tracks. The Separate 
List for Each Channel option has no effect on audio tracks; you can always 
select any combination of sound channels.

Renaming the List

FilmScribe inserts the name of your first loaded sequence into the Title text 
box. This becomes the default name of the list.

To give the list a different title name:

t Type it in the Title text box. This title appears as the name of the list when 
you print or save it.

Using the Options Pane

The Options panes contain specific options that apply to different types of 
lists. The Cut List tool has eight option displays:

• Global options affect the overall content of all lists and their display 
options. 

The following displays provide a menu from which you select the information 
you want to see on the list, including key numbers, timecodes, reel 
information, and so on.

• Assemble list options include standard film and timecode tracking 
numbers, transition indications, and custom information such as 
comments and locators.

• Optical list options include film and timecode tracking numbers, custom 
column information, keyframe, optical footage, and page break 
information.

• Dupe list options include film and timecode tracking numbers, custom 
column information, tolerance, and handle length information. Dupe 
handles default to one frame and are adjustable.
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• Pull list options include film and timecode tracking numbers, custom 
column information, pop-up menus for three levels of sorting, 
specifications for spooling method, and inclusion of opticals and film 
leader. The same options are available for Optical Pull lists, Scene Pull 
lists, and Optical Scene Pull lists.

• Optical Pull lists contain just the elements contained within an optical 
list. The default setting is for anything that is not a straight cut.

• Scene Pull lists contain the entire scene (flash to flash) as logged for each 
element in the Timeline. The list contains the scene only once even if it is 
used several times in the sequence. You must enter information in the bin 
Scene heading to create a Scene Pull list.

• Optical Scene Pull lists contain the same information as Scene Pull lists, 
but only for scenes used in an optical. The default setting is for anything 
that is not a straight cut. You must enter information in the bin Scene 
heading to create an Optical Scene Pull list.

The Change List tool has one additional basic option display:

• Change list options include specifications for listing only changes, for 
combining deletions, and for assigning preview code. You can also set the 
counter start number for the viewing footage in the Global Options pane.

n For a complete description of all the options, see Chapter 3.

Selecting Options

To select options:

1. Click a list type in the Lists pane.
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The list type is highlighted in the Lists pane, and the options for that list 
type appear in the Options pane (the right half of the tool). A check mark 
indicates which lists will be created.

2. Select check boxes, select from pop-up menus, or type in text boxes to 
select the options you want.

Copying Options Between List Types

After selecting assemble list options, you can apply the same options to other 
list types.

To copy options to another list type:

1. Select the assemble list options you want.

2. Click another list type in the Lists pane.

3. Click the Same As Assemble List button (in the Change List tool, click 
the Same As Change List button) at the top of the Options pane.
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To copy options to all other list types:

t In the Cut List tool, click the Update All Cut Lists button in the Assemble 
List Options pane.

t In the Change List tool, click the Update All Change Lists button in the 
Change List Options pane.

Changing the Options

You can change the cut list options or the change list options any time before 
or after generating a list.

To adjust the options and update the list:

1. Alter your selections in the Options pane.

2. Regenerate the list.

Using Settings to Save, Recall, and Remove Options

The Settings feature allows you to save a set of options under a specific name. 
You can then quickly recall those options when you need to apply them again. 
The Settings feature remembers which list types you have chosen to generate, 
as well as all the options you have selected in the Options pane. The Settings 
feature does not remember which sequences you have loaded, or the title or 
track selection.

To recall a previous setting:

t Click the Settings pop-up menu, and select a setting.
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To save the current options as a setting:

1. Select Settings > Save As.

A dialog box opens.

2. Type a name for the setting, and then click OK.

To remove settings:

1. Select Settings > Remove Settings.

The Remove Settings dialog box opens. 

2. Select the setting you want to remove, and then click Remove.

3. Do one of the following:

t Click Done to remove the settings permanently and close the Remove 
Settings dialog box.

t Click Cancel to restore any settings you have removed and close the 
Remove Settings dialog box.
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Previewing the List

After selecting options for your lists, you are ready to generate the lists and 
preview them in the List window. 

To generate the lists and open the List window:

1. Select the list types you want to generate by selecting the appropriate 
check boxes in the Lists pane. 

2. Click the Preview button at the bottom of the Cut List tool or the 
Change List tool.

The Preview button performs the following operations depending on the 
template you are using:

- For the TabbedLists template, FilmScribe prompts you for a folder 
name and stores the cut list or the change list in the folder. You can 
open the file later in an application such as Microsoft Excel.

- For the WebLists template, FilmScribe stores all the related files in 
Avid Application/FilmScribeOutput/Title, and then opens the HTML 
file in your default Web browser.

- For all other templates, FilmScribe generates the list and opens the 
List window for previewing the list.

n The Animation and Storyboard templates support only Assemble lists in the 
Cut List tool and are not supported templates in the Change List tool.

Check 
boxes
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Working in the List Window

n This section applies to all the list templates except for WebLists and 
TabbedLists templates.

When you generate a list, it opens in a List window. You can use this window 
to view your list and to change its appearance. When you open a saved list, it 
also appears in a List window. 

n For information on working with WebLists, see “Using the WebLists 
Template” on page 57. For information on working with TabbedLists, see 
“Using the TabbedLists Template” on page 62.

Opening a List Window

To open a List window, load a sequence, and then do one of the 
following:

t Click the Preview button in the Cut List tool or the Change List tool.

t Open a previously saved list. See “Saving, Opening, and Printing Lists” 
on page 56.

Before you save a list, the title bar of the List window reads “Cut List 
Preview” or “Change List Preview.” After you save a list, and when you open a 
saved list, the title bar shows the name of the saved list.

List window status bar
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You can use the standard Windows or Macintosh controls to scroll through the 
list within the window or to resize the window so that you can see more of the 
list.

Understanding the List Window Status Bar

The following table describes the icons and messages that can appear in the 
List window status bar:

Expanding and Collapsing Lists

Generated lists appear in the List window with heading bars. These bars 
indicate the list type and enable you to collapse or expand each list. You can 
also expand or collapse all lists at once, switching from a view that shows all 
your lists in full to one that shows only the heading bars.

List Window Status Bar Messages  

Message Description

Appears on the left side of the status bar:

 List is current Indicates that the list matches the current option 
settings in the Cut List tool or the Change List tool.

 List is NOT current If you generate a list and then return to the tool to 
change options, this message appears. It indicates 
that the list no longer matches the current option 
settings in the Cut List tool or the Change List tool.

Regenerate the list to make it current again.

Appears on the right side of the status bar:

Modified Indicates that you have modified the list in the 
window since it was last saved. This message also 
appears for a newly generated list that you have 
not yet saved.

Saved Indicates that the list in the window exactly 
matches the saved list.
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(Macintosh only) To expand or collapse a list:

t Click anywhere in the heading bar.

To expand or collapse all lists:

t Select List > Expand Lists or List > Collapse Lists.

Using the List Summary Option

When there are multiple tracks, clicking the List button brings you to the 
beginning of the group of assemble lists, not to the list you selected. This is 
also true for other lists, such as optical lists.

If you select List Summary in the Global Options pane, a list summary appears 
above all the other lists. This summary has its own heading bar and also 
displays a navigation button to the left of each list summarized.

To move to the top of a particular list:

t Click the button for that list in the list summary.

n If you have only one list open, clicking the button for that list in the list 
summary also closes the list summary.

Editing and Formatting Lists

The List window functions as a basic text editor. You can edit and format your 
lists in a variety of ways to customize them for your particular needs. You can 
do the following:

• Add comments

• Cut, copy, and paste material

• Use typographical distinctions (font type or style, text size or color) to 
highlight parts of the list
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This feature enables you to alert the readers of your lists to special issues and 
concerns. You can also easily create slightly different versions of the same list, 
for different audiences, by commenting and highlighting the list in different 
ways and then printing individual copies. 

c All the text except the title bar or headings bars that displays in the List 
window can be edited. Typically, you do not want to change the generated 
information that is in the list. Take care not to delete important material.

To add a comment to your list:

t Move the cursor to the place where you want the comment, and type your 
comment.

n You might want to use a different text color for any comments that you add in 
the List window. (Select a color from the Color menu, and then type your 
comments.) You can then easily distinguish them from comments made earlier 
in the editing process.

For information on editing commands, see your Windows or Macintosh 
documentation.

To edit material in the list:

t Select the material you want to edit, and then select the appropriate 
command from the Edit menu.

To highlight text using typographical distinctions:

1. Select the text you want to highlight.

2. Select the typographical effect you want from the Font, Style, Size, or 
Color menu.

n You cannot change these parameters in Weblists or TabbedLists.

n If you are able to print your lists in color, or if they will be viewed onscreen by 
their intended readers, color is probably the most effective way to highlight 
your lists. You can highlight all comments in red, for example. Or you can 
provide comments in different colors, keying each color to the needs of a 
particular reader of the list.
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Changing the Appearance of Text in Generated Lists

After generating a list, you can modify its appearance by changing the font 
and the font’s style, size, and color. These changes affect the whole list.

To alter your list’s appearance:

1. Select the text that you want to modify.

2. Select the appropriate item from the Font, Style, Size, or Color menu.

Viewing Sequences as QuickTime Movies

If the sequence with which you are working is available to FilmScribe as a 
QuickTime movie, and you select the Frame Images option in the Global 
Options pane of the Cut List Tool or the Change List Tool windows, the list 
that you generate includes a thumbnail image of the head frame for each event 
in the list.

The image thumbnails provide an immediate visual reminder of the sequence. 
You can also use these thumbnails to open the QuickTime movie of the 
sequence in the Movie window. You can then play all or part of the sequence.

To use this feature, first export your sequences from your Avid editing system 
as QuickTime movies (.mov) files, and make those files available for 
FilmScribe to read them. You must have QuickTime loaded on your computer. 
For information on preparing QuickTime movies of sequences and making 
them available to FilmScribe, see “Preparing QuickTime Movies” on page 88. 
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Opening Movie Sequences

To open a sequence in the Movie window:

t Click the image thumbnail.

The Movie window opens, displaying the frame of the movie sequence 
represented by the thumbnail.

You can also open a movie directly into the Movie window by choosing File > 
Open and then opening the movie file.

n List files created by the WebLists template can be opened in any web browser 
on either Macintosh and Windows systems. List files generated by other 
FilmScribe templates are not compatible across platforms. You cannot open a 
list created in FilmScribe for Macintosh by using FilmScribe for Windows, or 
vice versa.

Controlling the Play of Movie Sequences

You can control how a movie sequence plays in the Movie window by using 
controls on the window itself and using commands in the Movie menu. You 
can also use commands in the Movie menu to alter the size of the Movie 
window.

The following table describes the controls in the Movie window.

Movie Window Controls  

Control Description

Play/Pause button Click to play a movie. When a movie is playing, the 
Pause button is displayed. Click the Pause button to 
stop play.

Slider The horizontal bar is a graphical representation of the 
length of the movie. The slider marks the point in the 
movie that is currently displayed. Click on the bar to 
move to any specific point in the movie. Drag the 
slider along the bar to fast forward or rewind through 
the movie.

Step Backward button Click to step backward one frame.
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The following table describes the commands in the Movie menu that control 
movie play or the size of the Movie window.

Step Forward button Click to step forward one frame.

Movie Window Controls (Continued)  

Control Description

Movie Menu Commands  

Command Description

Loop Plays the movie repeatedly. When the system reaches 
the end of the movie, it returns to the beginning and 
starts play again.

Loop Back and Forth Plays the movie repeatedly, in alternating directions. 
When the system reaches the end of the movie, it 
starts to play the movie backward from the end point.

Play Selection Only Plays only a selection of the frames in the movie. 
Playback jumps from one selected frame to the next.

Play All Frames Plays every frame in the movie.

Half Size Decreases the size of the Movie window by half, 
which can increase the movie playback speed.

Normal Size Returns the Movie window to its default size.

Double Size Doubles the size of the Movie window. Increasing 
the window size allows you to see images more 
clearly but can slow down movie playback.
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Saving, Opening, and Printing Lists

When the list is ready, you can print it immediately or save it as a text file that 
you can bring to another location, import and use in another system, or open 
and print at a later time. 

After the list is saved, you can edit it in a text editor. For example, you can add 
comments for an assistant editor or a negative cutter.

n List files created by the WebLists template can be opened in any web browser 
on either Macintosh or Windows systems. 

Saving Lists

To save a list:

1. Select File > Save.

The Save Options dialog box opens.

2. Select the desired option, and then click OK.

A dialog box opens.

3. Type the file name in the File name text box.

4. Select a destination for the file.

5. Click Save.

n (Windows only) Avid recommends that you use the .txt file name extension at 
the end of all list names. FilmScribe works best with saved lists that have this 
file name extension. (This does not apply to lists generated with the WebLists 
template.)
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Opening a Saved List

To open a previously saved list in a List window:

1. Select File > Open.

A dialog box opens.

2. Navigate to the location of the file you want to open.

3. Click the file name, and then click Open.

n You cannot open an HTML file from within the Open dialog box.

Printing Lists

To print a list:

1. Select File > Print.

The standard Print dialog box opens.

2. Select the Print options you want, and then click OK (Windows) or Print 
(Macintosh).

FilmScribe prints the list exactly as it appears in the List window. 

Using the WebLists Template

The WebLists template allows you to create an HTML cut list or change list. 
These lists can be viewed in any standard web browser. You can post these 
lists to an intranet, enabling collaboration between groups. These lists are 
hyperlinked, which allows you to jump between lists. For example, you can 
click on an Optical entry in the Assemble List, and it opens a browser at the 
information in the Optical List. You can also take advantage of the browser’s 
support for printing.
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The following illustration shows an example of a cut list generated by the 
WebLists template.

To create a list with the WebLists template:

1. Select Template > WebLists in the Global Options pane.

2. Click the Preview button.

FilmScribe stores all the related files in Avid 
Application/FilmScribeOutput/Title.

For example, the Assemble List is called Assemble.html. In addition, 
control files are also copied to this folder (.jpg files for the banner and 
logo, .css files containing formatting information, and some Javascript 
code). When the HTML file is created, the Browser automatically 
launches.
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n If you want to view WebLists on another system, copy the entire folder, not just 
the HTML file.

n List files created by the WebLists template can be opened in any web browser 
on either Macintosh or Windows systems. List files generated by other 
FilmScribe templates are not compatible across platforms. You cannot open a 
list created in FilmScribe for Macintosh by using FilmScribe for Windows, or 
vice versa.

3. You can view the following in HTML cut lists:

- Opticals in the Assemble List that are linked to their description in the 
Optical list 

- Items in the Optical List that are linked to the appropriate event in the 
Assemble List.

- Duplicates in the Assemble List that are linked to the entries in the 
Dupe List
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- Events in a Dupe Group in the Dupe List that are linked to locations 
in the Assemble List

- Pull List items that are linked to their location in the Assemble List

4. You can view the following in change lists:

- Change, Change Pull, Change Discard, and Optical items.

- Change lists that are hyperlinked to the old and new Assemble and 
Pull Lists.

5. To print your list, use the browser’s print setup option (choosing fonts, 
text size, and so on).

n You can save your HTML files as pdf files while in the browser.

n At this time, certain List options are not available with the WebLists template: 
Monospace Font, Size, and Icons.

You can use the QuickTime player at the top of the browser page to play the 
entire sequence. For more information on creating QuickTime movies to use 
with the Frame Images option, see “Preparing Sequences” on page 86.
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If you also generate the dupe list, you can click the hypertext link to display 
the related event in the dupe list. The following illustration shows a Dupe list.

Hypertext 
link
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Using the TabbedLists Template

The TabbedLists template allows you to create a list that you can open in a 
separate application such as Microsoft Excel or FileMaker® Pro. The 
TabbedLists template supports all the lists and options.

To Create a List with the TabbedLists Template:

1. Select Template > TabbedLists in the Global Options pane.

2. Click the Preview button.

You are prompted to name the folder.

3. Name the folder, and then click OK.

If the folder already exists, the system informs you that it will delete the 
current contents of the folder. Click OK or click Cancel to stop this 
process.

4. A .txt file for each list is created and placed in the folder.

5. You can then view the lists with any standard text editor. 

n You can also drag the list to a spreadsheet program, such as Microsoft Excel.

Working with Multiple Cuts and Reels

In the advanced stages of a project, you might need to make cut lists or change 
lists for conforming work prints or making comparisons between multiple cuts 
or reels. FilmScribe provides specific features that allow you to:

• Create a single cut list for several sequences so you can compile them for 
a single conformed cut

• Create change lists for multiple screening reels so you can update the 
conformed reels, make comparisons between sequences, or adjust breaks 
between reels in preparation for a final cut

Creating a Cut List for Two or More Sequences

With two or more sequences loaded, the system generates one cut list with 
appended sections for all sequences in their listed order. The cut list provides 
lists for the sequences in order.
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To create a single cut list for several sequences:

1. Make sure the sequences are named so that they are sorted in the proper 
order in the Cut List tool.

2. Ctrl+click (Windows) or Shift+click (Macintosh) the chosen sequences in 
the bin, and then drag them to the Sequences pane.

3. Select the options you want, and then generate the list.

The cut list provides lists for the sequences in order.

Creating Change Lists Across Multiple Reels

When you load comparable sequences, FilmScribe generates consecutive, 
appended lists for each set of cuts. You can make comparisons based either on 
reel numbers or on preview code that you assign to each sequence.

Depending on the options you select, the new list notes any of the standard 
change categories across the reels:

• Insertions of new material

• Deletions of material no longer needed

• Trims to be made to the heads and tails of the edits

• Moves that consist of a matched pair of deletions and insertions

• Optional information that details which portions of the sequence should 
not be altered

In addition, you can generate separate lists for each set of reels and 
simultaneously generate a single dupe list that describes duplicated shots 
across all the reels. These topics are described in this section.

Using Reel Numbers

When you use reel numbers to generate change lists for multiple reels, observe 
the following conditions:

• For each sequence, the old version and the new version must have exactly 
the same reel number in order for the system to make the appropriate 
comparisons.

• The reel numbers must be entered into the Reel # column in the bin for 
each sequence.
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• The reel numbers must be consecutive so that the system can generate 
lists that match the appropriate order of the reels; for example, sequence 
1.1, sequence 1.2, and so on.

• You must have an equal number of old and new sequences. If necessary, 
create a dummy sequence to balance the reels.

To generate a change list using reel numbers:

1. Prepare the sequences with the appropriate reel numbering if necessary.

2. Ctrl+click (Windows) or Shift+click (Macintosh) all the old sequences in 
the project bin (each sequence must represent a different reel).

3. Drag the selected sequences into the Old Sequences pane to load them. 

4. Repeat steps 2 and 3 for the new sequences, dragging them into the New 
Sequences pane. Each new sequence must represent a different reel that 
shares the same reel ID as the corresponding old sequence.

5. Add sequences to the lists as necessary by pressing and holding the Alt 
key (Windows) or Option key (Macintosh) while dragging the selections 
into the appropriate Sequences pane.

6. Select the options you want and generate the list.

Using Preview Code

Preview code is an optional numbering system that you can use to ink each 
conformed work print with continuous numbers that you match for the 
corresponding sequence in FilmScribe.

Preview code applies to one generation of changes on the work print only. 
You must re-ink each successive work print and enter those preview code 
numbers as KN Start numbers for each new revision of a sequence. 

n You can request that the lab differentiate successive generations of preview 
code by applying different colors.

Preview code both supplants comparisons based on reel numbers and provides 
the advantage of continuous numbering within each generation of a sequence 
or cut.
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c Because new material edited into the sequence has not yet been inked 
with preview code, you must select the options for displaying key 
numbers or ink numbers for referencing the original source footage for 
these clips in the list.

To track changes with preview code in the Avid editing system (or in 
Avid MediaLog) and in FilmScribe:

1. After re-inking the first work print with preview code, enter the matching 
start preview code number in the KN Start column of the bin for the 
corresponding sequence.

c Change the starting key number for the sequence only. Do not override 
KN Start information for the original master clips used in the sequence.

2. Duplicate the sequence, and then place the original into an archive bin.

3. Rename the duplicate, but be sure to maintain the same reel number in the 
Reel # column of the bin.

4. Continue editing the duplicate sequence.

5. When the time comes to generate a new change list in FilmScribe, load 
the old and new sequences, and then select Preview Code from the 
Change List options.

6. After the work print is reconformed, ink the new work print with new 
preview code, and enter matching numbers in the KN Start column for the 
corresponding sequence (the duplicate of the original sequence).

7. Duplicate this sequence, and then continue the same cycle as often as 
necessary.

KN Start column
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Dupe Checking Across Multiple Reels

If your project consists of multiple reels, it probably has a separate sequence 
for each reel. These reels, however, might share footage that requires 
duplication. FilmScribe allows you to check for dupes across multiple reels 
within one change list.

To generate a dupe list for multiple reels:

1. Follow the steps described in “Using Reel Numbers” on page 63 for 
loading comparable reels into the Change List tool.

2. When choosing options for the list, select Assemble list, Dupe list, and 
Reel Numbers options.

Using the Matchback Option

The matchback option that is available on some Avid editing systems allows 
you to generate a film cut list from a 30-fps video project that uses film as the 
source material. This video-to-film conversion is useful in a variety of 
matchback circumstances, including the following:

• To generate a videotape master for the project along with a final cut on 
film

• To generate pull lists for retransferring selects at high quality before 
online editing

n Editors working on a film matchback project for the first time should pay close 
attention to duplicate material in the final edited piece. Use Dupe Detection in 
the Timeline and verify any dupes flagged.

Understanding Matchback

The matchback process refers back to the video edit information for your 
sequence and performs a conversion to create a matching 24-fps cut list.

Because of the difference in frame rates between video and film (30 fps or 
25 fps for video versus 24 fps for film), the conversion of video edit points 
might fall within a film frame, requiring the addition or subtraction of a frame 
in that edit event in the resulting cut list. 
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For example, with a ratio of 24 film frames to 30 video frames, a seven-frame 
video edit corresponds to approximately 5.6 film frames. However, film cuts 
cannot include partial frames, so the edit must be rounded to five or six 
frames.

The following adjustments occur during matchback:

• If the total video-sequence duration at the end of each cut is a frame 
longer than the film, then the system subtracts a frame from the last video 
edit. If the video is a frame too short, a frame is added to the last video 
edit. 

• Where an essential frame was added or subtracted to the beginning or end 
of each edit, the system adds matchback information to the cut list stating 
that matchback shortened or lengthened the tail of the clip by one frame. 
The assistant editor or negative cutter can use this information to check 
the edit.

• Each track in the sequence must be corrected independently because the 
start and end points for split edits are different for each track. As a result, 
the picture and audio for a matchback video edit might be out of sync by 
no more than one frame.

Matchback is subject to the following limitations:

• The matchback option uses key numbers to conform the negative. 
Therefore, you must have key number information entered in the bins for 
the project.

• You can generate cut lists but not change lists in a matchback project.

• The matchback information applies to the picture only. You must generate 
a separate list (an EDL, for instance) for conforming the audio source 
tapes.

..........................................................................................................

Clip X Clip Y Clip Z
NTSC 
video

Film

The matching film edit point falls within a 
frame.

..........................................................................................................
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• Be sure to remove unwanted match frames (add edits) from your sequence 
before generating the cut list. Otherwise, the calculation of matchback 
frames includes these edits. For more information, see Appendix A.

Generating a Cut List with Matchback

To generate a cut list with matchback, you must first set up matchback options 
at the project level in your Avid editing system. For more information about 
setting up matchback options while starting a project, see the Help for your 
Avid editing system.

To generate a cut list with matchback information:

1. Create a sequence.

2. Use the procedures for getting a sequence, selecting tracks, and choosing 
settings, as described in “Working with the Cut List Tool and the 
Change List Tool” on page 36.

n All templates are available with matchback projects.

n When you select Global options, select the Matchback Info option in the 
Options pane to display the matchback information in the list.



Chapter 3
Film List Options

This chapter explains all the options you can use to customize your cut and 
change lists. It includes the following main sections:

• Cut List Global Options

• Cut List Options Common to All Lists

• List-Specific Cut List Options

• Change List Global Options

• Change List Options Common to All Lists

• List-Specific Change List Options

Cut List Global Options

Global options affect the appearance and format of all the generated lists. The 
following table describes the global options.

Cut List Global Options  

Option Suboption Description

Template

Animation Displays a list that is customized for animators, 
including a running counter, frames, durations, and the 
clip name. The first and last frame of each clip are 
displayed, along with additional information that you 
select.
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Columnar Displays columns of selected information in the 
simplest information-display format.

Locators Displays only clips that contain locators. For more 
information about locators, see “Cut List Options 
Common to All Lists” on page 74 and the Help for your 
Avid application.

OpticalBlock Lists all opticals graphically (instead of textually).

Storyboard Displays a list that is customized for animators, 
including the clip name, scene, and take. The starting 
frame of each clip is displayed in rows of four.

TabbedLists Allows you to create a tab-delimited cut list or change 
list that you can save and open in another application, 
such as Microsoft Excel, or FileMaker Pro. For more 
information, see “Using the TabbedLists Template” on 
page 62.

WebLists HTML-based lists that can be opened in a Web browser 
for viewing or printing. See “Using the WebLists 
Template” on page 57.

Picture Conforming Selects the conforming method that is used to conform 
the picture. This option has no effect on sound lists. 
This affects how standard-length dissolves and fades 
are treated.

This option is not present for change lists, which 
always assume A-roll conforming.

A Roll (Single Strand) All transition effects, regardless of type or length, are 
treated as opticals.

A/B Roll (Double Strand) Standard-length dissolves, fade-ins, and fade-outs are 
placed directly in the assemble list and are not treated 
as opticals unless they are part of some other optical 
effect such as a motion effect. The standard lengths are 
16, 24, 32, 48, 64, and 96 (frames).

Cut List Global Options (Continued)  

Option Suboption Description



Cut List Global Options

71

Using Key Number (KN Start)
Ink Number
Auxiliary Ink
DPX
VFX
Transfer

Select the type of numbers to use to conform the 
picture. FilmScribe uses this value to ensure that those 
numbers exist for all sources. If a source lacks the 
required numbers, the Cut List tool displays a message 
box.

Sound 
Conforming 

Ink Number

Auxiliary Ink

Select the type of numbers to use to conform the sound 
tracks. FilmScribe uses this value to ensure that those 
numbers exist for all sources. If a source lacks the 
required numbers, the Cut List tool might display a 
message box.

Running Footage as Total Frame Count
Total Frames 3 perf
35mm, 2perf
35mm, 3perf
35mm, 4perf
35mm, 8perf
16mm, 20perf
16mm, 40perf
65mm, 5perf
65mm, 8perf
65mm, 10perf
65mm, 15perf

Specifies the format in which to display the 
incrementing count for the sequence.

Durations as Frames 

Footage

Displays the duration in the specified number of 
frames.

Displays the duration in the format selected under 
Running Footage as.

Master TC Track TC1 (Start)
TC 24
TC 25P
TC 25
TC 30 DF
TC 30 ND
TC 30 NP
TC 60

Select which timecode track you want to be used to 
display the master timecode in the list.

30 fps drop-frame
30 fps non-drop-frame
30 fps no pulldown

Start At Specify the footage to be used as a starting point in the 
master.

Cut List Global Options (Continued)  

Option Suboption Description
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Display Handles Select Display Handles, and then type a handle size. 
FilmScribe adds a new With Handles column to the 
lists for each source column for WebLists and 
TabbedLists templates. The With Handles column 
contains the start and end values of the column and 
adds a handle of the specified size.

n Other templates show values including the 
handles.

Separate List for 
Each Channel

Generates a separate set of lists for each selected 
picture track. Multitrack (multilayer) effects are 
ignored and replaced with the foreground track from 
the effect. Single-track effects are treated as usual. 

When this option is not selected, the Cut List tool 
generates one set of lists for all selected picture tracks 
combined. This is the normal mode of operation.

This option affects how the track selectors behave on 
the Cut List tool.

Frame Images After you create a QuickTime movie of the sequence 
this option displays a thumbnail frame image for each 
clip in the cut list or change list. (You can print the 
frame image.) FilmScribe prompts you for the location 
of the QuickTime movie, and then displays the starting 
frame from each event in the sequence.

Widescreen Select this if you are displaying frame images and the 
frames are 16x9 aspect ratio. Deselect it if the frames 
are 4x3.

Icons Includes representative icons in your assemble list to 
identify each A/B-roll fade-in, fade-out, dissolve, and 
dupe in the sequence (not applicable to single-strand A-
roll or work print). These icons reference only 
standard-length dissolves; therefore, a 7-frame dissolve 
is referenced as an optical in the cut list, not as a 
dissolve. Note that icons used in change lists are 
different; they reference each deletion, trim, or 
insertion required to update the work print. For more 
information about icons in lists, see “Understanding the 
Cut List Tool” on page 37.

Cut List Global Options (Continued)  

Option Suboption Description
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Show Prefix Identifies cuts in the cut list or change list by displaying 
the entire first and last key number for each cut. The 
generic prefix includes the code at the start of each key 
number, as in KN 12 3400. Deselect this option to 
include the entire key number for the first frame of each 
cut but only the footage and frame count for the last 
frame of each cut, minus the KN prefix.

Matchback Info Available only for NTSC. Shows what modifications 
were made during the matchback process. To use this 
option, you must have selected matchback at the project 
level. This option does not control whether matchback 
is performed. You determine whether matchback is 
performed when you create the project.

Disable Perf Slip Instructs the Cut List tool to ignore audio perf slipping 
and offset data when displaying ink numbers.

Ignore Color Effects Instructs the Cut List tool to generate the cut list 
without color effect information.

Ignore All Special 
Characters from 
Display

Instructs the Cut List tool to generate the cut list 
without graphic icons, header images, or QuickTime 
movie images.

Cut List Global Options (Continued)  

Option Suboption Description
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Cut List Options Common to All Lists

When you select one of the lists in the Cut List tool, the Options pane shows 
the options for that list type. 

Most options are the same for all the list types; these common options appear 
at the top of the display. Options that are specific to the selected list type 
appear at the bottom of the display.

n FilmScribe can reference and include in lists only information that has been 
logged into bins using an Avid editing system or Avid MediaLog. Make sure 
you enter any information that you need before you attempt to generate lists in 
FilmScribe.

Common 
options

List-
specific 
options
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The following table describes the common options.

Cut List Common Options  

Option Description

Set All Cut Lists
Same As Assemble List

Set All Change Lists
Same As Change List

These options appear at the top of the Options List depending on which tool and 
list is currently selected. These options allow you to copy options between other 
lists types.

 KN Start Displays film reference numbers based on data from the KN Start column in the 
bin.

Ink Number
Auxiliary Ink 
Labroll 
Camroll 
Soundroll 
Reel #
Slate 
Scene & Take 

Usually applies to work prints and sound track editing. Displays user-definable 
numbers from corresponding columns in the bin. If there is no corresponding bin 
column, it means you did not log this data when you captured; the system can 
display only information that you logged for the project. 

Name Name of the source clips used in your sequence (master clips and subclips).

Comments Includes comments about cuts or transition effects that you added to the sequence 
by using the Add Comments menu command in your Avid editing system. For 
information on adding comments, see the Help for your Avid editing system.

Locators References sequence locators in the cut list or change list. Locators are markers 
applied to particular frames during an edit session to indicate special attributes 
such as music cues, sound effects, clap markers, and so on. If the editor’s locators 
contain comments, they are also displayed in the cut list when you select this 
option. For information on adding locators, see the Help for your Avid editing 
system.

TC1 (Start) Start timecode Source timecode based on the TC Start bin 
column, counting at the same rate as the 
project.

Master TC Master timecode Sequence timecode based on the Master Start 
bin column, counting at the same rate as the 
project.
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Sound TC Address-track timecode Source timecode based on the starting value 
in the Sound TC bin column, counting at the 
same rate as the project.

Auxiliary TC 1-5 Custom or duplicated timecode Source timecode based on the Aux TC bin 
columns, counting at the same rate as the 
project.

Aux TC 24 Custom or duplicated timecode Source timecode based on the Aux TC24 bin 
column, counting at 24 fps.

Film TC Film timecode generated through 
the telecine transfer

Source timecode based on the starting value 
in the Film TC bin column, counting at the 
same rate as the project. The column is 
generated by telecine transfer. Used to track 
timecode recorded on the original film 
negative during production

TC 24 For 24p and 25p projects Source timecode based on the starting value 
in the TC24 bin column, counting at 24 fps.

TC 25 For 24p and 25p projects Source timecode based on the starting value 
in the TC25 bin column, counting at 25 fps.

TC 25P For 24p and 25p projects Source timecode based on the starting value 
in the TC25 bin column, counting at 25 fps, 
but with the 13th frame dropped.

TC 30 DF Drop frame Source timecode based on the starting value 
in the TC30 bin column, counting at 30 fps, 
drop frame.

TC 30 ND 30-fps non-drop-frame timecode. Source timecode based on the starting value 
in the TC30 bin column, counting at 30 fps, 
non-drop frame.

TC 30 NP  with no pulldown Source timecode based on the starting value 
in the TC30 bin column, counting at 30 fps, 
no pulldown.

TC 60 60-fps timecode Used for 720p-60 HD projects.

Tape ID Identifies the tape ID of the tape, as defined in the TapeID bin 
column.

Cut List Common Options  (Continued)  

Option Description
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List-Specific Cut List Options

Options that are specific to a particular list appear at the bottom of the Options 
pane. The following sections explain the list-specific options for each type of 
list available in the Cut List tool.

Pullin Src Identifies the source frames as either A, B, C, or D frames. The original pulldown 
cadence from the NTSC source tapes.

Pullin Rec Identifies the newpulldown cadence created by the edited version.

DPX Frame-counting field for Digital Picture Exchange, a SMPTE standard describing 
frames scanned from film. The format is the following: a descriptor of up to 32 
alphanumeric characters, followed by a hyphen (-), followed by a six-digit frame 
count, for example, DPXChildDocu-023657.

VFX Frame-counting field for visual effects. The format is the following: a descriptor of 
up to 32 alphanumeric characters, followed by a hyphen (-), followed by a 
six-digit frame count, for example, FXChildDocu-023657.

VFX Reel Source reel identification for the FX shot.

LUT File name of the color look-up table used for the series of clips or frames. 

Transfer Frame-counting field for sources that have been prepped for transfer. The format is 
the following: a descriptor of up to 32 alphanumeric characters, followed by a 
hyphen (-), followed by a six-digit frame count, for example, 
CameraRoll23-000001.

UNC Path Universal Naming Convention that specifies the location of resources on a server. 
The location you enter becomes a hyperlink to that location.

Summary Displays selected options. Click again to return to the menu.

Custom Bin Column To add data from a custom column on a per cut basis, specify the custom column 
name. The name must be identical (including case) to the name as it appears in 
the bin.

Cut List Common Options  (Continued)  

Option Description



 Chapter 3 Film List Options

78

Assemble Lists

The following table describes options specific to the assemble lists. 

Assemble List Options  

Option Description

LFOA (Last Frame of Action) Determines the duration of a sequence at the last frame 
that is part of the sequence, minus the length of the head and/or tail. Select the 
option and enter the length of the head and/or tail.

Mark Short Cuts Searches the assemble list for cuts that are shorter than a user-specified minimum. 
All such cuts are flagged with a comment.

Mark Jump Cuts Searches the assemble list for jump cuts that are shorter than a user-specified 
minimum. All such cuts are flagged with a comment. A jump cut occurs when a 
short piece of material is “missing” between adjacent cuts from the same source 
material.

Show Trans. FX as Cuts Shows transition effects, such as dissolves, as comments in the assemble list rather 
than as opticals.
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Optical Lists

The following table describes options specific to optical lists.

Dupe Lists

The following table describes options specific to dupe lists.

Optical List Options  

Option Description

Key Frames Controls whether or not optical keyframes from the sequence are shown in the 
optical list. This option also displays information for Paint and AniMatte™ effect 
options. 

If you change the keyframe parameters of an effect, the change is reflected in the 
change list only if you select this option. 

Optical Footage Shows footage relative to the beginning of each optical.

Page Breaks Between 
Opticals

Each optical prints on a separate page.

Dupe List Options  

Option Description

Assume Handles Specify the number of frames for handles during dupe checking. The frames are added 
to the beginning and the end of each clip before checking for overlap. (The handles are 
not reflected in a list but are used for internal calculations.)

Print w/Handles Specify the number of frames for handles after dupe checking. The frames are added and 
displayed at the beginning and end of each clip in the list.
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Pull Lists

The following table describes options specific to Pull, Optical Pull, Scene Pull, 
and Optical Scene Pull lists.

Pull  List Options  

Option Description

Sorting These options control how a list is sorted. They affect only pull lists. They do not affect 
assemble, optical, or dupe lists.

You can select up to three sort fields (criteria). 

First sort by None
Labroll
Camroll
Soundroll
Scene Take
Name

Second sort by Same choices as First sort by
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Change List Global Options

Like the cut list, the change list has global options that apply across the entire 
change list, affecting all other list selections. Global options in the Change List 
tool are identical to those in the Cut List tool. For more information, see “Cut 
List Global Options” on page 69.

Third sort by KN Start
Ink Number
Auxiliary Ink
DPX
VFX
Transfer
TC1 (Start)
Film TC
Sound TC
Auxiliary TC 1 through TC 5
TC 24
TC25P
TC 30 ND
TC 30 DF
TC 30 NP
Aux TC 24
TC 60

Order Heads Out (ascending edge numbers)
Tails Out (descending edge numbers)

Place separators Controls where separators are placed in the list. The separator’s appearance depends on 
the template; usually it appears as a horizontal line.

First Sort Field 
Second Sort Field
Keycode or Ink Prefix
Prefix or every 1000 ft

Include Leader Specifies whether to include leaders in the list.

Pull  List Options  (Continued)  

Option Description
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Change List Options Common to All Lists

When you select a list name in the Change List tool (except for Global), the 
Options pane shows the options for the list type. Most options are the same for 
all the list types; these common options appear at the top of the display.

These options are identical to the common options on the Cut List tool. For 
more information, see “Cut List Options Common to All Lists” on page 74.

List-Specific Change List Options

List-specific options appear at the bottom of the option display. The following 
sections explain the list-specific options for each of the list types available in 
the Change List tool.

Change List

The following table describes options specific to change lists.

Change List Options  

Option Description

Show Only Changes Limits the entries in the change list to insertions, deletions, trims, and moves. 
There is no explicit indication of sections that remain unchanged. If this option is 
not selected, the change list also contains events that explicitly show sections that 
remain unchanged.

Combine Deletions Forces each group of adjacent deletions to be combined into a single event. If this 
option is not selected, each deleted clip has its own event in the change list.

Preview Code Displays preview code numbering. For more information on using preview code, 
see “Using Preview Code” on page 64.
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Change Pull and Change Discard Lists

Options for change pull lists and change discard lists are almost the same as 
the options for the pull  lists on the Cut List tool. For more information, see 
“Pull Lists” on page 80. The only difference is that the Include Leader option 
is not available for change pull and change discard lists.

Optical List

The options for optical lists on the Change List tool are the same as the options 
for optical lists on the Cut List tool. For more information, see “Optical Lists” 
on page 79.
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Appendix A

Preparing Sequences for 
FilmScribe

This appendix provides information to help you prepare your sequences in an 
Avid editing system so that FilmScribe can work with them successfully and 
you can maintain your sequences safely. It includes the following main 
sections:

• Entering Film Information

• Preparing Sequences

• Tracking Frames Based on File Names

• Preparing QuickTime Movies

Entering Film Information

The process of working in an Avid editing system includes entering 
information associated with the clips that you capture and the sequences that 
you build while editing. This information might be logged before you capture 
media or added to a bin later. 

For film projects, some of this information is essential for capturing. You must 
have information in the Start and End video timecode columns. For transfers 
to NTSC video, you must have pulldown frame information in the Pullin 
column. Other film information is not essential to the basic editing workflow, 
but it might be necessary for your particular project.
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You must enter any information that you want FilmScribe to include in a 
generated cut list or change list before you work with sequences in 
FilmScribe. You cannot alter Project settings, edit bin information, or add new 
bin headings within FilmScribe itself.

For example, if you need to present information such as Scene and Take 
numbers, camera rolls, or audio timecode as part of a cut list or change list, 
you must have entered the information into the bin, either through the logging 
process or by editing the bin manually.

For procedures about supplying this information, see the Help for your Avid 
editing system.

n You can open a saved list in a text editor or a word processor and then edit the 
list to add information to it. You might find this useful for adding comments to 
aid the assistant editor or negative cutter, but it is not a practical way to add 
numbering information for every clip and event in the list.

Preparing Sequences

Depending on the type of list you are creating, and the stage of your project, 
you might need to prepare the sequences before working with them in 
FilmScribe. A normal workflow for each stage of list generation might be as 
follows.

Generating the First Cut List

To generate the first cut list for conforming a work print, do the following 
in your Avid editing system:

1. Make sure the tracks you want are selected.

2. Remove any unwanted add edits (match-frame edits) by removing 
match-frame edits.

3. Duplicate the sequence and place the original sequence in an archive 
backup bin.

4. Keep the copy of your sequence in a current cuts or a work-in-progress 
bin, and generate lists in FilmScribe from the archived original.
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For the work in progress, you can keep the file name extension .Copy01, 
created when you duplicated the sequence, as a way of indicating that it has 
been properly archived. You can also remove the word copy, but be sure to 
maintain the numbering of each successive cut so that you do not lose track.

Generating a Change List

As you continue working on the sequences, use the Change List tool to update 
the work print as necessary. 

To generate a change list for a conformed work print:

1. Make sure the tracks you want are selected in the new (revised) sequence, 
remove any unwanted add edits, copy the sequence, and place the original 
in the archive bin, as described in “Generating the First Cut List” on 
page 86.

2. Use successive versions of the sequence stored in the archive to generate 
the change lists. Try to maintain one sequence version for each time you 
conform the work print.

Comparing and Combining Cuts and Reels

Often in the later stages of editing, you might need to compare several cuts or 
versions or to combine two or more reels that have already been conformed. 
Tips and techniques for preparing and managing multiple sequences are 
described in “Working with Multiple Cuts and Reels” on page 62.

Generating a Final Cut List

When you are ready for the final cut, you can prepare the sequences and 
generate lists and other reference elements for the negative cutter.

To generate a final cut list:

1. Make sure the tracks you want are selected, and remove any match frames 
(add edits).

2. Back up your project and bins.

3. Record a digital cut to tape, preferably with burn-in, as described in the 
Help for your Avid editing system.

4. Prepare assemble lists for each reel by key number.
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Tracking Frames Based on File Names

Bins can display a digital file name for each frame in addition to key numbers, 
ink numbers, and other reference numbers. Tracking frames with the frame 
number is useful in the film scanning process, where each frame is an 
independent file. It is also useful when working with effects and animation 
processes that are dependent on a frame-based counting scheme. You can 
include the frame number when you generate a cut list using FilmScribe.

The naming and counting scheme consist of a prefix (8-character maximum), 
separated by a dash (-), and followed by 6 characters that count as total 
frames. For example, FXS32v01-000001 identifies the first frame of a series 
of frames that belong to an FX shot for Scene 32 version 1. As the FX shot 
progresses during the creative process, the version number increases.

To display the frame count numbers in a bin and cut list:

1. In the Film Settings dialog box of the Avid editing application, select 
Frame Count from the “Ink Number Default Edge Type” option or the 
“Auxiliary Ink Default Edge Type” option.

2. In a bin, select Ink Number or Auxiliary Ink from the Bin Headings dialog 
box.

The Ink Number and Auxiliary Ink columns display the frame count 
numbers in the bin. 

3. Open the bin in FilmScribe and choose Ink Number or Aux Ink options. 
Then generate the cut list.

The cut list includes the frame count numbers.

Preparing QuickTime Movies

To take advantage of FilmScribe’s image thumbnail and movie playback 
features, you need to export your sequences from your Avid editing system as 
QuickTime movie files, and make those files available for FilmScribe to read 
them. For more information, see “Viewing Sequences as QuickTime Movies” 
on page 53.
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Preparing Sequences for Export

To help speed up the export and keep your data safe, consider doing the 
following to prepare your sequence before you export:

t Make sure all media for the sequence are online.

t Archive the sequence. Duplicate the sequence, place the duplicate in 
another bin, and prepare the duplicate for export. The original sequence is 
unaffected.

t Render all effects. Any unrendered effects are rendered on export, but this 
can take extra time during the export process.

t Mix down multiple video or audio tracks for faster export, unless you 
need to preserve the multiple track information.

Exporting QuickTime Files

For information about exporting QuickTime movies from your Avid editing 
application, see the Help for that application. In general, use settings that 
create a QuickTime movie that is easy to display over an internet connection. 
For example, the Same As Source option creates a large file that might take 
too long to display over an internet connection.

n Certain characters create problems for FilmScribe when it searches for file 
names. Do not use a slash (/) or a colon (:) in the names of sequences that you 
plan to save as QuickTime movies.

Guidelines for File Naming

When FilmScribe generates a cut list that includes frame image information, it 
searches for the QuickTime movie by looking for a specific file name in a 
specific location.

The file name that FilmScribe searches for is the first eight characters of the 
name of the sequence itself, followed by the QuickTime file name extension 
that identifies the movie format. For example, if you have a sequence named 
“Program1,” FilmScribe searches for an associated movie file named 
“Program1.mov”.
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This file name format is the one your Avid editing system uses by default 
when it saves the movie file. The simplest way to handle movie file names is 
to accept this default name when you export, so that FilmScribe finds it 
automatically when it searches.

If you want to change the file name or use a longer name, you can still find the 
file in FilmScribe. When FilmScribe does not find the movie file, it allows you 
to browse for the movie using the Open dialog box (Windows) or Directory 
dialog box (Macintosh) to specify the file name.

n Certain characters create problems for FilmScribe when it searches for file 
names. Do not use a slash (/) or a colon (:) in the names of sequences that you 
plan to save as QuickTime movies.

Guidelines for File Location

FilmScribe creates a folder called Sequence Movies within the FilmScribe 
folder. This is the default location that FilmScribe searches for movie files.

The simplest way to handle movie files is to place them in this folder so that 
FilmScribe can find them automatically. If you can navigate to this folder 
when you export the movie from your Avid editing system, you can save the 
movie to the folder directly. Alternatively, you can move the movie to this 
folder later.

If you want to keep your movie files in a different location, you can still find 
them in FilmScribe. When FilmScribe does not find the file in the Sequence 
Movies folder, it allows you to search for the movie using the Open dialog box 
(Windows) or Directory dialog box (Macintosh) to browse the full directory 
structure available on your computer.

When you are deciding where to locate your movie files, remember that their 
playback is affected by the time your computer takes to access them. Movies 
stored on a hard drive on the computer running FilmScribe play better than 
movies stored on slower storage media or stored elsewhere on a network.
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24p or 25p 24-fps or 25-fps progressive media. The progressive media file is composed of 
single frames, each of which is vertically scanned as one pass. The Avid 
system creates 24p or 25p media by combining (deinterlacing) two video 
fields into a single full, reconstructed frame. For NTSC film-to-tape transfers, 
the system creates 24p media by undoing the 2:3 pulldown inserted by the 
telecine process, removing the extra fields, and creating progressive frames.

bin A database in which master clips, subclips, effects, and sequences are 
organized for a project in an Avid editing system. A file structure that contains 
other files, including sequences, and is analogous to a folder or a directory in 
other computer applications.

black edits 1. A video source with no image. 2. A special source you can fade into, out of, 
or use for other effects.

B-roll An exact copy of the A-roll original material, or new original material on a 
separate reel, for use in A/B-roll editing.

conform To make the final show based on the editing. Conforming organizes the source 
material for final assembly.

cut An instantaneous transition from one video source to another. Also, a section 
of source or record tape.

dissolve A video or audio transition in which an image from one source gradually 
becomes less distinct as an image from a second source replaces it.

DPX Frame-counting field for Digital Picture Exchange, a SMPTE standard 
describing frames scanned from film. The format is the following: a descriptor 
of up to 32 alphanumeric characters, followed by a hyphen (-), followed by a 
six-digit frame count, for example, DPXChildDocu-023657.
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dupe list A list of dupe reels. A view of this list is available only if options are set for 
creating a dupe list. You can set the options in the EDL Manager Options 
window.

dupe reel A reel designated for the recording and playback of dupes (duplicate shots) 
during videotape editing. You create dupe reels as backup copies, to help in 
the creation of special effects, and for A/B-roll editing. 

event A number assigned by the editing system to each performed edit. In most 
computer editing systems, defines an action or a sequence of actions 
performed by the computer in a single pass of the record tape.

fade A dissolve from full video to black video or from full audio to no audio, or 
vice versa.

fps Frames per second, pronounced “fips.”A measure of the film or video display 
rates. (NTSC = 30 fps; PAL = 25 fps; SECAM = 25 fps; Film = 24 fps.)

handles Additional source material before and after edit points; you use a handle for 
later adjustments.

import ID The internal identification for your Avid source tape.

linear editing Tape editing in which you assemble the program from beginning to end. If you 
require changes, you must rerecord everything downstream of the change. The 
physical nature of the medium (for example, analog videotape) dictates how 
you must place material on the medium. See also nonlinear editing.

LUT File name of the color look-up table used for the series of clips or frames. 

master list A list that specifies the starting event number, reel ID options, and timecode 
options.

matchback 
conversion

The conversion from film to video frame rates.

nonlinear editing A type of editing in which you do not need to assemble the program from 
beginning to end. The physical nature of the medium and the technical process 
of manipulating that medium do not enforce or dictate how the material must 
be physically ordered. You can use nonlinear editing for traditional film 
cutting and splicing, and captured video images. You can make changes at the 
beginning, middle, or end of the sequence. See also linear editing.
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NTSC National Television Standards Committee. The group that established the 
color television transmission system used in the United States. The standard 
calls for 525 lines of information scanned at a rate of approximately 30 frames 
per second.

overrecord To use a long shot from one reel, then place shots from other reels over the 
continuous shot.

PAL Phase Alternating Line. A color television standard used in many countries. 
PAL consists of 625 lines scanned at a rate of 25 frames per second.

patching The routing of audio or video from one channel or track in the sequence to 
another.

reel ID The reel identification (ID) FilmScribe uses to refer to the master reel source. 
The reel ID can come from tape, sound roll, camera, or auxiliary sources.

slicing and dicing Isolating trouble spots in a sequence by repeatedly dividing the sequence in 
half, creating a cutlist for the isolated half, and testing for successful 
generation.

SMPTE Society of Motion Picture and Television Engineers. One of the principal 
standards organizations for the film and video industry. See also timecode.

suite Standard industry name for the site of editing. A room or rooms containing 
such equipment as the edit controller computer, videotape machines, monitors, 
an audio mixing board, a videotape switcher, and other peripheral devices.

super Superimposition. One shot half-dissolved over another.

template A set of FilmScribe options saved under a specific name. You can use 
templates to save settings you use frequently and apply them quickly.

timecode An electronic indexing method for editing and timing video programs. 
Timecode denotes hours, minutes, seconds, and frames (00:00:00:00) elapsed 
on a videotape.

Address track timecode is recorded simultaneously with the video picture. 
Longitudinal timecode (LTC) is recorded on an audio track. Vertical interval 
timecode (VITC) is recorded in the vertical blanking interval of the video 
track. SMPTE timecode is the prevalent standard.
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Other timecodes include film timecode and audio timecode used during film 
projects. During editing, an Avid editing system can display and track several 
types of timecode. See also SMPTE.

track isolation The process of creating a separate list for each video track to simplify the 
composition.

transfer Frame-counting field for sources that have been prepped for transfer. The 
format is the following: a descriptor of up to 32 alphanumeric characters, 
followed by a hyphen (-), followed by a six-digit frame count, for example, 
TransferChildDocu-023657.

UNC Universal Naming Convention that specifies the location of resources on a 
server. The location you enter becomes a hyperlink to that location.

VFX Frame-counting field for visual effects. The format is the following: a 
descriptor of up to 32 alphanumeric characters, followed by a hyphen (-), 
followed by a six-digit frame count, for example, FXChildDocu-023657.

wipe A shaped transition between video sources in which a margin or border moves 
across the screen, wiping out the image of one scene and replacing it with 
another.
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comments in cut lists 16
comments to lists 52

Appearance of text in lists
changing 53

A-roll conforming
defined 18

Ascending order
in bins 36

Assemble list
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options 43, 78

Aux. Ink option (Cut List tool) 75
Avid MediaLog 16, 65

B
Bad Clip icon 28
Bins

adding information to 16
adding ink numbers to 16
opening and closing 34
sorting items in 36
working with 34

Blend effects 20

C
Camera Roll option (Cut List tool) 75

Change discard list
described 23
options 83

Change list
common options 82
compared to cut list 14
creating across multiple reels 63
described 14
generating 87
global options 81
list-specific options 82
options 44

Change List tool
changing options 46
closing 36
features 37
opening 36

Change pull lists
described 23
options 80

Changing
appearance of lists 53
list options 46

Chroma key effect 20
Clip Name option (Cut List tool) 75
Clone effects 20
Closing

bins 34
Collapsing

lists 50
Color look-up table (LUT) 77
Combining

cuts and reels 87
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Comments 16
Comparing

cuts and reels 87
Controlling

movie sequence play 54
Creating

change lists across multiple reels 63
multiple sequence cut lists 62

Cut list
adding comments in 16
common options 74
compared to change list 14
creating with multiple sequences 62
described 14
generating final 87
generating first 86
generating with matchback 68
global options 69
list-specific options 77

Cut list options
common 75
global 69
sorting 80

Cut List tool
changing options 46
closing 36
features 37
opening 36

Cut list types
assemble list 18
dupe list 21
optical list 19
optical scene pull list 24
pull list 23
scene pull list 24

Cuts
comparing and combining 87
working with multiple 62

D
Delete Head icon 28
Delete icon 27
Delete Tail icon 28

Descending order
in bins 36

Digital cut
when to use 14

Displaying
movie frames in cut list 16

Dissolve icon 27
Dissolves

laboratory-standard 19
supported in optical lists 20

Double-strand conforming
defined 19

Dragging
sequences from bins 40

Dupe checking across multiple reels 66
Dupe icon 27
Dupe list

described 21
options 43, 79

E
Editing

16mm film 19
35mm film 18

Edits
icons for 27

EDL (edit decision list) 14
Effects

supported by optical list 19
Entering

film information 85
Expanding

lists 50
Exporting

QuickTime movies to FilmScribe 89

F
Fade In icon 27
Fade Out icon 27
Fades

laboratory-standard 19
supported in optical lists 20
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File location
guidelines for movie files 90

File names
guidelines for movie files 89

Film
editing 16mm 19
editing 35mm 18
masks 21
optical lists 19
types of lists 14

Film information
entering 85

FilmScribe folder
default location for movies 90

Final cut list
generating 87

Flips and flops 20
Frame count numbers

tracking with ink numbers and file names 88
Frame images

in lists 16
Frame reference numbers 15

G
Generating

cut list with matchback 68
lists 48

Getting sequences from bins 40
Global options 43

H
Head frames 16
Heading bars

in lists 50
Highlighting

text in lists 52
HTML cut list or change list 57
Hyperlinks in WebLists template 57

I
Icons

in lists 27

using to represent edits 27
Image thumbnails 53
Ink number list

when to use 14
Ink numbers

adding to bins 16
displaying frame count numbers 88

Ink Numbers option (Cut List tool) 75
Insert Head icon 27
Insert icon 27
Insert Tail icon 28
Interface 31

K
KEM roll 28
Key number list

when to use 14
Key Numbers option (Cut List tool) 75

L
Lab Roll option (Cut List tool) 75
Laboratory-standard effects 19
List headings bars 50
List options

changing 46
selecting 43

List Summary navigation 51
List Summary option 51
List window

status bar 50
working in 49

Lists
adding comments to 52
changing appearance of 53
changing fonts in 53
contexts for using 13
custom titles for 37
expanding and collapsing 50
frame images defined 16
frame reference numbers in 15
generating 48
icons in 27
previewing 48
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printing 56, 57
renaming 43
saving 56
types of 13, 14
understanding 37
viewing 48

Lists pane (Cut List and Change List tools) 37
Locator comments 16
Logging

film information 85
Luma key effect 20
LUT (color look-up table) 77

M
Masks

film 21
Matchback 66�68
Matchback Info Option (Cut List tool) 73
Matte key effect 20
Media Offline icon 27
MediaLog 16, 65
Menus

described 31
general 31
window-specific 32

Movie files
file location guidelines 90
file name guidelines 89

Movie sequences
controlling play of 54
opening 54

Multiple reels
and cuts 62
combining 87
creating change lists with 63
dupe checking across 66

Multiple sequences
creating cut lists from 62

N
Numbers

for reels 63
frame reference 15

O
Opening

bins 34
Cut List and Change List tools 36
movie sequences 54
saved lists 57
settings 46

Optical icon 27
Optical list

effects supported in 19
options 43, 79
when to use 14

Optical Media icon 27
Optical scene pull list 24
Optional lists 17

P
Paint effects 20
Picture Conforming option (Cut List tool) 70
Picture-in-Picture effect 20
Play/Pause button (Movie window) 54
Preparing

QuickTime movies for FilmScribe 88
sequences for FilmScribe 86

Preview button 38, 48
Preview code

described 64
tracking changes with 65

Previewing
lists 48

Printing
lists 56

Pull list
described 17, 23
options 43, 80
when to use 13

Q
QuickTime movie sequences 16
QuickTime movies

exporting to FilmScribe 89
preparing for FilmScribe 88
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viewing sequences in 53
Quitting

FilmScribe 30

R
Reels

comparing and combining 87
multiple, working with 62
numbers for 63

Removing
settings 47

Renaming
lists 43

S
Saved lists

opening 57
Saving

lists 56
Scene pull list 24
Segment effects 20
Selecting

list options 43
tracks in Cut List and Change List tools 42

Sequence Movies folder 90
Sequences

dragging from bins 40
preparing for FilmScribe 86
viewing as QuickTime movies 53

Sequences pane (Cut List and Change List tools) 37
Settings

saving 46
using 46

Single-layer effects 21
Single-strand

conforming 18
Single-strand conforming

defined 18
Slider (Movie window) 54
Sorting

items in bins 36
Sorting option (Cut List tool) 80
Sound Conforming option (Cut List tool) 71

Sound Roll option (Cut List tool) 75
Standard film effects 20
Starting

FilmScribe 30
Status bar

in List window 50
Step Back button (Movie window) 54
Step Forward button (Movie window) 55
Superimposition effect in optical list 19
Switching

sort order in bins 36

T
TabbedLists

generating 62
Template option (Cut List tool) 69
Templates

TabbedLists, generating 62
WebLists, hyperlinks in 57

Text
changing in lists 53
highlighting in lists 52

Thumbnail images 16
Title effect 20
Title text box (Cut List and Change List tools) 37, 43
Tracking

changes with preview code 65
Tracking frames with frame numbers 88
Tracks

selecting in Cut List and Change List tools 42
Tracks pane (Cut List and Change List tools) 37

U
UNC Path 77
Universal Naming Convention (UNC) path 77

V
VFX (Visual Effects)

format for 77
Viewing

lists 48
sequences as QuickTime movies 53
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Visual Effects (VFX)
format for 77

W
Weblists

generating 57
Windows

types in FilmScribe 33
Workflow

in FilmScribe 29
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